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1. Product Overview

11

1.2

1.3

The Ascendance Wireless Network Management System ( ANMS ) is used to
configure and manage wireless networks of SECURELINX nodes. ANMS has been
designed to provide network administrators with a comprehensive and simple way

to control and configure their network nodes.

Compatibility and Requirements

The ANMS software operates on any PC or Mac supported by Java. That is any
version of Microsoft Windows (98/ME/2000/NT/XP /Vista ) or GNU/Linux.

ANMS Features

1 Optimized communication protocol between SECURELINX's
software and ANMS featuring high levels of interactivity.
Additionally an advanced encryption scheme can guarantee secur e

configuration and monitoring of SECURELINX nodes
Easy wizard -based configuration of ~SECURELINX Hot - Spot
Easy WISP Configuration Wizard

New graph -based statistics providing real time bandwidth
utilization per network interface

New robust netwo rk topology display
Built -in Multi Router Traffic Grapher (MRTG) support

SecureLINX Features

=

Advanced fault tolerant mechanisms guaranteeing node stability.
Advanced Hotspot functionality

Web Redirect (Universal Access Method)
MAC Authentication

Bandwidth Management

User Information and Radius Statistics
Walled Garden

Advertisement URLsS

Configurable redirection page

Multiple bridged high speed interfaces
Administration MAC

Radius Attributes Support

WAN Interface configuration (PPPoE, PPTP)

DHCP leases information a  dded.

= =2 =4 A4 A4 A5 -4 -5 -5 -2 -5 -2 -2




1.4

1.5

Wireless Functionality

Advanced Wireless Security (WPA, 802.1x)
Best Channel Selection Algorithm

Country Code Selection (+ out of band modes)
Wireless to wireless traffic filtering

Mac Address Spoofing

Advanced Firewall functionality

= =2 =42 4 -4 A -2

NTP (Network Time Protocol) service

ANMS Installation Guide

For a Windows installation, double -click the SECURELINX_vX_setup.exe installer
and follow the prompts. The installer comes bundled with jre 1.4, so you do not
have to pre -install it.

For a Linux or M acintosh installation, unzip the ANMSVX jars.zip file and launch
the application as java T jar ANMSvX.jar from the current directory. JRE (v1.4)
must be preinstalled.

ANMS

If your goal is to deploy several wireless access points in one system, central
management is recommended. Even if you plan to begin with a smaller network,

but expect to expand in the future, a centrally managed system should be
considered. The  Ascendance Wireless Network Management System ( ANMS)
provides an effective, turnkey management solution that covers the needs of most

users.

Using ANMS you can:
1 Manage access points and devices on the wireless network
Configure network nodes, polling settings, and other para meters
Load and save network configurations

1
1
1 Configure and view network topology
1 Auto -discover available nodes

1

Analyze network traffic using the Multi Router Traffic Grapher
(MRTG)

Overview of ANMS Interface

The user interface utilizes typical drop down menus, short cut menus (right click)
and tabbed/sub -tabbed panes inside the main window.

ANMS Main Window

The ANMS window is a graphical user interface that facilitates viewing, configuring

and monitoring your wireless network. The interface includes a typ ical main menu,
tabbed panes containing graphical and textual information and shortcut menus

that allow you to navigate to other windows, tabs and dialog boxes.




k] s
File Tools Utilities Help
[P |
| Network Topology [ Device List |
QW REK
% 192.168.1.3
Ayggﬂdﬂﬂw
=y
1911%{
Status of node 192.168.1.3: Firmware Yersion: Key Level:
Up Time (dihimis): ANMS Connectivity: (] 4%
ANMS Main Window
Main Menu
The ANMS window features a menu system with four main menu headings: File ,
Tools , Utilities and Help .
File | Tools Liilities Help

Save Profile

Save Profile As

Load Profile

Load Background Image |

INMS Settings ?

Exit

ANMS Main Menu System

Tabbed Panes

The main body of the ~ ANMS window displays information in tabbed panes. When
ANMS starts the Network Topology tab is availabl e. This tab contains three
information panes: the Topology Map |, the Registered Node List and the Node
Status pane.

B Ascendance Manager Version:1.1.14b 4l £
File Tools Utilities Help

@[

| Advanced Configuration of node: " 192.168.1.3" 1
| Configuration | Statistics | System Properties |

Network | Wireless | Dynamic Routing Firewall Senices HotSpot

IP Configuration

| Interface Configuration | Static Routing

ANMS Tabbed Panes




1.5.1

Node Shortcut Menu

Many other functions are accessible via the Node Shortcut Menu , Which includes
the following items: GUI -Node Connectivity Settings, Open Status Window,

Advanced Node Configuration, Save Configuration, Unlock, Back Up, FW

Upgrade, Reboots, Current Throughput, Wisp Easy Wizard (WEW) and
Remove. From the Node Shortcut Menu you can access additional tabbed

win dows used in configuring and monitoring the network.

GUI-Node Connectivity Settings
Open Status Window

Advanced Node Configuration
Sawve Configuration

Unlock 3
Back Up 3
P Upgrade

Reboot

Current Throughput

WISP Easy Wizard (WEW)
Remave

Node Shortcut Menu

ANMS Main Menu

Using ANMS menus you can manage system profiles, implement tools to discover,
add and view nodes, launch utilities and access help information. RW menus
include:

File
1 Save Profile T Save the current ANMS profile
1 Load Profile 7 Load a previously saved  ANMS profile
1 Load Background Image i Load a background image (typically a

map) to be displayed in the Topology Map
T ANMS Settings 1 Set polling interval and polling port values
1 Exit 7 Exit ANMS

Tools

1 View Topology i Display the Topology Map tab

1 Add New Node i Open the Insert New Node dialog box

1 License Manager 1 Display the License Manager tab

1 Discovery Manager T Open the Auto Disco very dialog box
Utilities

T MRTG i Openthe MRTG window
Help

1 Home Page 1 Accessthe Ascendance Wireless website

1 About 7T Display s the SECURELINX introductory window




1.5.2 Network Topology Tab Information Panes

File Tools Utilities Help
S o
| Network Topology [ Device List
4 RRK
% 192.168.1.3
4 ceendance
(&1
Node List Topology Map 4192.153.1.3[
g ge——
Status of node 192.168.1.3: Firmware Version:  [2.3.2 - COMMERCIAL Key Level:
Node Status Up Time (chimis): ANMS Connectivity: i 4%

The ANMS Window

Topology Map

Located in the center pane, the Topology Map displays icons representing
network nodes and connection information describing the layout of the network. It
also can display a map graphic in the background.

Registered Node List

Located in the left pane, the Registered Node List displays all registered nodes
on the network

Node Status

Located in the bottom pane, the Node Status area displays the following
information on the currently selected node

1 Firmware Version T The number representing the firmware
version residing in the node

Up Time 1 The length of time the node has been operating
Key Level

ANMS Connectivity i The ratio of successfully received probe
responses

All panes are resizable and can be adjusted according to user preferences.




1.5.3

Node Shortcut Menu

GUI-Hode Connectivity Settings
Open Status Window

Advanced Node Configuration
Save Configuration

Unlock 3
Back Up 3
A Upgrade

Rehoot

Current Throughput

WISP EasyWizard (WEW)

Remaove

Node Shortcut Menu

GUI-Node Connectivity Settings

The GUI -Node Connectivity Settings menu option allows you to access the
Node Connectivity Settings dialog box (for the curr  ently selected node).

Open Status Window

The Open Status Window menu option allows you to access the Status dialog
box, which contains the FW Version, Key Level, Up Time and Host Name
fields. (The FW Version, Key Level and Up Time fields also are displayed in the

Node Status  pane of the Topology Map  tab.)

Advanced Node Configuration

The Advanced Node Configuration menu option allows you to retrieve
information fr om the selected node. A new pane is displayed containing a main tab
(Advanced Configuration of node: [node name]. Under this tab three sub -
tabs are displayed: Configuration, Statistics and System Properties. Each of
these tabs contains several additional s ub -tabs used in the configuration process.

Save Configuration

The Save Configuration menu option allows you to permanently save the
configuration for the current node.

Note: After the base station is configured, the configuration parame ters are
stored in RAM (volatile memory). If the base station is powered down the
configuration wil/l be | ost unless you Save Co
permanent memory.
Back Up
The Back Up menu option allows you to back up and rest ore the configuration
settings for the selected node.
FW Upgrade
The FW Upgrade  menu option allows you to access the Select dialog box, from

which you can select the firmware image file to be loaded into the node.

n f
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Reboot

The Reboot menu option allows you to reboot the node.

Current Throughput
The Current Throughput menu option allows you to display a real
display of transmit and receive traffic of the network interface.

WISP Easy Wizard (WEW)

The WISP Easy Wizard (WEW) menu option allows you to start a wizard that
provides an easy and convenient way to install and configure wireless nodes. (See
Chapter O for details)

-time graphical

Remove

The Remove menu option allows you to remove the currently selected node from
the Topology Map  and Registered Node List

Getting Started with ANMS

Starting from the menus and windows mentioned above, you can auto
and insert new nodes, display maps and graphics of your wireless network, save
and load profiles and access multi -tabbed windows used for advanced
configuration of nodes.

-discover

Auto - Discovering Nodes

Discovery Manag er allows you to discover nodes and insert them into the
Topology Map. A custom polling protocol is used to detect SECURELINX nodes in
the specified subnet . Discovered nodes are displayed in a tabular format.

To use Discovery Manager

T In the Tools menu, select Discovery Manager The Auto

Discovery dialog box appears.

Network Subnei: 24 D Enable Broadrast Disco'\-'ery

Timveowt: secs

Dizcovery Results [ |

IF | Host Hame | Include to topolagy | Pasgwond
19216813 localhost =]
| Stat | | Swmit | | Cancel

Auto Discovery Dialog Box
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Network Subnet

In the Network Subnet field, type the subnet address. ( ANMS will detect nodes
in which the first three segments, or 24 bits, of their IP address match the first
three segments of the subnet address.)

Enable Broadcast Discovery

Select the Enable Broadcast Discovery checkbox. ( ANMS uses a UDP broadcast
message to dete ct any nodes on the network.)

Timeout
Inthe Timeout field, type a timeout value in seconds (default: 10 seconds)

Discovery Results

Click Start to initiate a discovery poll. The Discovery Results bar graph displays
the progress of the poll. When complete, the table displays the IP Address , Host
Name and Password (if used) of discovered node. The checkbox under Include

to Topology is automatically selected.

Include to Topology

To display a node in the Topology Map , leave the Include to Topology
checkbox sele cted.

Submit
Click the Submit button to insert the nodes into the Topology Map.

Cancel
Click the Cancel buttonto exitthe  Auto Discovery dialog box.
Icons for each node should be visible in the Topology Map , labeled with the
hostname. If two nodes have the same default hostname, ANMS will label one with
the hostname and the other with its IP address. (The label can be changed to an
Alias using the  GUI -Node Connectivity Settings dialog box, accessible from th e

Node Shortcut Menu.)

Configuring a New Node

Network nodes can be configured manually using the Insert New Node dialog
box.

1. Use any one of the following three methods to configure a new

node:
1 Right click anywhere in the topology pane, t hen click the Insert
new node button that appears
or
1 Click the icon
or

f Onthe Tools menu, click Add New Node . The Insert New Node
dialog box appears.
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IP Settings Displayed Icon
P address: 192 | [168 |1 |1 | alias: [localiost

S5H Settings
Password:  [**++*] |

@]

s ) [ o ) [ cawd

Insert New Node Dialog Box

2. Type the IP address , Alias (optional) and SSH Settings

Password . (Typically a new node is given the default password
admin)

3. Selecta Displayed Icon (optional) to represent the node.

Access Point @ Router
Dual Access Firewall
Point Router
Firewall - Voice
w; Gateway
- IP Telephony Wireless
[ ] H
4 t Router Bridge
Mobile Access E NAT
ﬁ Router
' Wireless
@ Router
(default icon)

List of Available Icons

Note: Though optional, adding  Alias and/or Displayed Icon provides an enhanced visual
representation of the nodes. This becomes especially useful when working with middle to large
scale networks.

4. Click the Add button. The icon will appear in the topology pane. All
topology panes are updated with the new insertio n information.
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Node Insertion

If the newly inserted node has successfully responded to a network probe, a green

=

localhost

indicates the node is not

outline appears around the icon. A red outline
responding.

1.6.3 Moving and Resizing Icons
1 To move a node icon, drag it to the desired location in the pane.

i To resize a node icon, select the icon, then drag one of its handles.

1.6.4 Adding Background Map Images

Topology Map can be further enhanced by loading a backg round image to
indicate the geographical location of the nodes. To add a background image:

On the File menu, click Load Background Image . The Load
Background Image dialog appears.

Browse to the image file you wish to load, select it and click the Load
Back ground Image button.

Note: .gif or .jpg formats may be used for background images

Adjust the magnification level of the background image using the
following zoom buttons located above the Registered Node List

bl Ee“ Zoom In

q 9‘ Zoom Out
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Create arrows indicating a connection between nodes by clicking in the
center of the source node (a hand cursor will appear), and dragging
to the center of the destination node. A line with arrowhead will
appear between the nodes.

Restore to default.

é

localhost

é

antcar

Network Nodes Showing  Connection

1.6.5 Saving and Loading Profiles
1. Tosave a Topology Profile ,onthe File menu, click Save Profile

2. Toload a Topology Profile, on the File menu, click Load Profile

1.6.6 Using the Node Shortcu t Menu

You can manage and configure a variety of operating parameters of network nodes
from the Node Shortcut Menu, which can be accessed using either of the
following methods:

1 Double click any node name shown in the Node List
or

1 Right click any node inth e Topology Map

GUI-Node Connectivity Settings
Open Status Window

Advanced Node Configuration
Save Confijuration

Unlock ]
Back Up »
W Upgrade

Rehoot

Current Throughput
WISP Easy Wizard (WEW)

Remove

Node Shortcut Menu




GUI-Node Connectivity Settings

Click this option to display the Node Connectivity Settings dialog box. This box
contains the IP Address and Alias assigned to the selected icon. If an Alias has
not been assigned, the Alias field will contain the Hostname of the node.

e —

P Address:  [192) [[162 |1 [[F |  Aliass llocalhost |

o
A

Ok | | Claricel

GUI -Node Connectivity Settings Dialog Box

IP Address
When ANMS scans the network it looks for the IP Address listed in this dialog. If
it makes a connection, the border around the icon turns green. If not, the border
is red.
Alias
To change the Alias , type the new name into the Alias text box.

Password
Type the password (default: admin) into the Password field. (This step is
required to allow access to Advanced Node Configuration described later in this
section.)

Node Icon

To change the node icon, select an icon from the drop down menu.

Submit Changes
Click the Submit Changes button to add the node to the Topol ogy Map and keep
the dialog box open

OK
Click OK to add the node and exit the dialog box.

NOTE : Changing the IP Address, Alias or Password, specifies the parameters assigned to the

currently selected node icon. The IP address and password will be used wh en ANMS scans the
network. Changing the IP address of the icon does not change the IP address of the node. If

the IP address of the icon is changed to an address not present on the network, the border of

the associated icon will turn red indicating no conn ection has been made.

Open Status Window

Click this option to access the Status dialog box, which contains the FW
(Firmware) Version, Key Level, Up Time and Host Name  fields. (The FW




Version, Key Level and Up Time fields also a re displayed in the  Node Status  pane
of the Topology Map  tab.)

f The FW Version field contains the version number of the firmware
residing in the currently selected node.

1 The Key Level field should display Level 2.
Up Time 1 The length of time the node has been operating

1 Host Name 1 The name of the currently selected node

. CumentSutsofmdelocalhost L3

FWVersion: [212- COMMERCIAL | Key Level:
Iip Time: 0:5:35:14 Az

Host Name:  [localhost |

oo

Current Status Dialog Box

Advanced Node Configuration
Click this option  to retrieve information from the selected node and open the

Advanced Configuration of Node tab .

NOTE: To access the Advanced Node Configuration you must first access the GUI -Node

Connectivity Settings via the Node Shortcut Menu and enter the password, then click OK or

Submit.
The Advanced Configuration of Node tab contains three sub -tabs:
Confi guration, Statistics and System Properties.

& 2io)
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| Advanced Configuration of node: "192.168.1.3" |
| Configuration I Statistics ] System Properties |
| network [ wireless | Dynamic Routing | Firewall | NAT | @os | senvices | DHCP | wian [ vian | Hotspot |

Advanced Node Configuration Tab with Sub -Tabs

Each tab contains several additional tabs. The mind map below shows the
hierarchy of advanced configuration tabs and sub -tabs used. The table indicates
the chapter where descriptions and configuration procedures for each tab are
located.




Tab Chapter
Network 3,4
VLAN 3

Wireless 5
Firewall 6

NAT 6
DHCP 7
WAN 8
Bandwidth
Manager 9
HotSpot 10
Services 11
Statistics 12

Tab/Chapter List

The table above indicates the chapters where descriptions and configuration
procedures for each tab are located.




Advanced Configuration Tab Hierarchy

Interface Configuration

Network tab Static Routing Routes
Rufes
AP
APClient
Wireless tab Radio
Sacurity
i Rules
Firewall tab
Flowmarks
NAT tab
SNVP
HTTP
Configuration tab | Services tab SSH
NTP
I l l Security
Se
Advanced DHCP tab . l”"‘gr
Configuration 4 clay
of Client
PPPoE
Node WAN tab o
Tab Structure PPTP
07/10/2005 - v4 VLAN tab
WAN
MNAT & Protection
Wireless
HotSpot tab Radius
Auth Type
Walled Garden
Advertisement
Web Customization
Summary
Packet Stats
Network tab ARP Entries
Open Connections
Statistics tab .
Wireless tab Packet Stats
Monitor Utils tab ICMP Ut
Trace Route
System Properties tab
Mind Map of Advanced Configuration Tabs and Sub -tabs

Save Configuration

Click this optionto  permanently save the configuration for the current node.




Note: After the base station is configured, the configuration parameters are stored in RAM
(volatile memory). If the base station is powered down the configuration will be lost unless you
SaveConfigur ati on to the base stationbés permanent memag

Back Up
Click this option and select:

1 Retrieve Configuration to Retrieve the last saved node
configuration

or

1 Restore Configuration to Restore the node configuration from a
file

GUI-Hode Connectivity Settings
Open Status Window
Advanced Node Configuration

Save Configuration
Unlock b

Back Up 3 Retrieve Configuration
Restore Configuration

P Upgrade
Rehoot

Current Throughput
WISP Easy Wizard (WEW)

Remowve

Back Up Menu Options

FW Upgrade

Click this option  to access the Select dialog box, from which you can select the
firmware image file to be loaded into the node.

Reboot
Click this option to reboot the node. An Alert dialog box appears with the
guestion: Should system save its configuration before reboot. Click Yes if
you want to save the configuration.

Current Throughput
Click this option to display a real -time graphical display of transmit and receive

traffic of the network interface.

WISP Easy Wizard (WEW)

Click this option to start a wizard that provides an easy and convenient way to

install new nodes. (See Chapter 0 for details)
Remove
Click this option to remove the currently selected node from the Topology

Map and Registered Node List




1.7

IP Networking

This section describes IP Networking settings and configuration procedures for
your Seccure LINX node.

To configure IP Networking , select the Interface Configuration tab, located
under the Advanced Configuration of Node, Configuration, Network tabs.

See Page 27 for a diagram showing Advanced Configuration tabs and sub -tabs.

The Interface Configuration tab features four panes:

1 Network Interfaces Tree (left pane)

1 Basic IP Configuration (top pane)

1 Global Settings (center pane)

1 Special Action Interface Commands (bottom pane)
Two buttons are located at the top of the IP Configuration tab:

T Refresh 71 Click Refresh to retrieve setting from the selected node.

T Submit T Click Submit to upload the configuration to the node.

Network Configuration Tab

Using the Network Interfaces Tree

The left pane of the IP Configuration tab contains the  Network Interfaces
Tree , a representation of all available network interfaces of the selected node. The
tree view can be expanded or collapsed by left clicking on any master interface.
When an interface is selected, data fields in the other panes display the
parameters associated with the selected interf ace and changes can be made.





































































































































































































































































































































